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7- Starting and Stopping a Simulation 

 To start execution of a model, select Start from the model editor's Simulation menu 

or click the Start button on the model's toolbar. You can also use the keyboard shortcut, 

Ctrl+T, to start the simulation. 

  

 

 

 

 

 

 

  

While the simulation is running, a progress bar at the bottom of the model window shows 

how far the simulation has progressed. A Stop command replaces the Start command on 

the Simulation menu. A Pause command appears on the menu and replaces the Start 

button on the model toolbar. 

8- Modeling Systems 

 One of the most confusing issues for new Simulink users is how to model systems. 

Here are some examples that might improve your understanding of how to model systems. 

Example-1: Converting Celsius to Fahrenheit 

To model the equation that converts Celsius temperature to Fahrenheit 

TF = 9/5(TC) + 32 
 

First, consider the blocks needed to build the model. 

 A Ramp block to input the temperature signal, from the Sources library  

 A Constant block to define a constant of 32, also from the Sources library  
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 A Gain block to multiply the input signal by 9/5, from the Math library  

 A Sum block to add the two quantities, also from the Math library  

 A Scope block to display the output, from the Sinks library  

 

Next, gather the blocks into your model window, assign parameter values to the Gain and 

Constant blocks by opening (double-clicking) each block and entering the appropriate 

value. Then, click the Close button to apply the value and close the dialog box. 

Now, connect the blocks. 

 

The Ramp block inputs Celsius temperature. Open that block and changes the Initial 

output parameter to 0. The Gain block multiplies that temperature by the constant 9/5. The 

Sum block adds the value 32 to the result and outputs the Fahrenheit temperature. 

Open the Scope block to view the output. Now, choose Start from the Simulation menu to 

run the simulation. The simulation runs for 10 seconds. 

Example-2: Modeling a Simple Continuous System 

To model the differential equation 

 

where u(t) is a square wave with an amplitude of 1 and a frequency of 1rad/sec. The 

Integrator block integrates its input x´ to produce x. Other blocks needed in this model 

include a Gain block and a Sum block. To generate a square wave, use a Signal Generator 
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block and select the Square Wave form but change the default units to radians/sec. Again, 

view the output using a Scope block. Gather the blocks and define the gain. 

In this model, to reverse the direction of the Gain block, select the block, then use the Flip 

Block command from the Format menu. To create the branch line from the output of the 

Integrator block to the Gain block, hold down the Ctrl key while drawing the line.  

 

An important concept in this model is the loop that includes the Sum block, the Integrator 

block, and the Gain block. In this equation, x is the output of the Integrator block. It is also 

the input to the blocks that compute x´, on which it is based. This relationship is 

implemented using a loop. 

The Scope displays x at each time step. For a simulation lasting 10 seconds, the output 

looks like this: 

 

The equation you modeled in this example can also be expressed as a transfer function. 

The model uses the Transfer Fcn block, which accepts u as input and outputs x. So, the 

block implements x/u. If you substitute sx for x´ in the above equation, you get 
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Solving for x gives 

 

or, 

 

The Transfer Fcn block uses parameters to specify the numerator and denominator 

coefficients. In this case, the numerator is 1 and the denominator is s+2. Specify both terms 

as vectors of coefficients of successively decreasing powers of s. In this case the numerator 

is [1] (or just 1) and the denominator is [1 2]. The model now becomes quite simple. 

 

The results of this simulation are identical to those of the previous model. 

Example-3: Modeling a Simple Control System 

 In this example we will model a simple control system and finding its time response 

according to these specifications:  

The Plant Transfer function (G(s))=
1s2s

1
2 

. 

The Feedback Transfer function (H(s))=
1s

1


. 

Note that to find the response for any control system, a step input is usually used.   

Assign parameter values to the blocks by opening (double-clicking) each block and 

entering the appropriate value. Then, click the Close button to apply the value and close 

the dialog box. Now, connect the blocks and view the response from the Scope block: 
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Example-4: Building a Channel Noise Model: 

 This section shows how to build a simple model of a communication system. The 

model, shown in the following figure, contains the most basic elements of a 

communication system: a source for the signal, a channel with noise, and means of 

detecting errors caused by noise.  

 

We encourage you to build the model for yourself, as this is the best way to learn how to 

use the Communications Blockset.  

Overview of the Model 

 The channel noise model generates a random binary signal, and then switches the 

symbols 0 and 1 in the signal, according to a specified error probability, to simulate a 

channel with noise. The model then calculates the error rate and displays the result. The 

model contains the following components. 

1. Source: The source for the signal in this model is the Bernoulli Binary Generator block,    

which generates a random binary sequence. You can get this block from the Data Sources 

sublibrary of the Comm Sources library.  
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2. Channel: The Binary Symmetric Channel block simulates a channel with noise. The 

block introduces random errors to the signal by changing a 0 to a 1 or the reverse, with 

a probability specified by the Error probability parameter in the block's mask. You 

can get this block from the Channels library.  

3. Error Rate Calculation: The Error Rate Calculation block calculates the error rate of 

the channel. The block has two input ports, labeled Tx, for the transmitted signal, and 

Rx, for the received signal. The block compares the two signals and checks for errors. 

The output of the block is a vector with three entries: 

 Bit error rate, which you expect to be approximately 0.01, since this is the probability 

of error in the channel  

 Number of errors  

 Total number of bits that are transmitted  

You can get this block from the Comm Sinks library. 

4. Display: The Display block displays the output of the Error Rate Calculation block. You 

can get this block from the Simulink Sinks library. 

Setting Parameters in the Channel Noise Model 

 To set block parameters in the channel noise model, do the following: 

1. Double-click the Binary Symmetric Channel block and set Error probability 0.01.  

Clear the box next to Output error vector. This removes the block's lower output port, 

which is not needed for this model.  

2. Double-click the Error Rate Calculation block and set Output data to Port to create an 

output port for the block. Select the box next to Stop simulation (This causes the 

simulation to stop after the target number of errors occurs or the maximum number of 

symbols is reached). 

Connecting the Blocks 

Next, connect the blocks as shown in the following figure. Make sure to connect the 

arrow from the Binary Symmetric Channel block to the input port labeled Rx on the Error 

Rate Calculation block.  
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The upper line leading from the Bernoulli Binary Generator block to the Error Rate 

Calculation block, shown in the following figure, is called a branch line. Branch lines carry 

the same signal to more than one block. 

Running the Model 

To run the model, select Start from the Simulation menu. After a few seconds, the 

model will stop automatically. To see all three boxes in the Display block, you must 

enlarge the block slightly by Selecting the Display block and move the mouse pointer to 

one of the lower corners of the block, so that a diagonal arrow appears on the corner, as 

shown.  

 

 

 

The Display block displays the following information: 

 The bit error rate  

 The number of errors  

 The total number of bits that are transmitted  
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Exercises: 

1. If a stone is thrown vertically with an initial speed u, its vertical displacement s after a 

time t has elapsed is given by the formula: 

                                                       s(t) = ut – gt
2
/2     (Air resistance has been ignored) 

Model this equation with a simulink diagram to obtain a plot for the vertical displacement s 

with time t. Where g=9.8 , u=40. 
 

Hints: 

First, consider the blocks needed to build the model. 

 A Ramp block to input the time signal t, from the Sources library.  

 A Math function block (double click on it and select square) to get t
2
, from the Math library.  

 A Gain block to multiply the input signal by u, from the Math library.  

 A Gain block to multiply the square of the input signal by g/2, from the Math library. 

 A Sum block to subtract the two quantities, also from the Math library.  

 A Scope block to display the output, from the Sinks library.  

Next, gather the blocks into your model window. Note that the output will not display a 

cleared output so right click on the display and select autoscale. 

2. If the exact number of bacteria at time t is given by the formula: 

N(t) = 1000 e
rt
 

Where r (growth rate per hour)=0.01 and t (in hours) is a ramp input 

Model this formula in a simulink diagram to obtain a plot for the bacteria growth (N) with 

time (t).  

Hint: 

The blocks needed to build the model. 

 A Ramp block to input the time signal t, from the Sources library.  

 A Gain blocks to multiply r with t, from the Math library.  

 A Math function block to get the exp, from the Math library.  

 A Gain blocks to multiply the result×1000, from the Math library. 

 A Scope block to display the output, from the Sinks library.  
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 3. Model the differential equation 

u(t)2x(t)(t)x5(t)x   

Where u(t) is a square wave with an amplitude of 1 and a frequency of 1rad/sec. View the 

output using a Scope block.. Hint: See example-2, page (6-13). 

4. Repeat problem-3 using the Transfer Fcn block. Hint: See example-2, page (6-14). 

5.  Model the differential equation 

u(t)2x(t)t(t)xx(t)x  )(  

where u(t) is a sine wave with an amplitude of 1 and a frequency of 10 rad/sec. View the 

output using a Scope block.. Hint: See example-2, page (6-13). 

6. Model the following control system and find its time response according to these 

specifications:  

     Plant Transfer function (G(s))=
1s3s

2
2 

, Feedback Transfer function (H(s))=
2s

2


,      

A forward gain (K) = 0.1, 1, and 10. 

Find the response for this system for each value of the gain (K). Note that to find the 

response for any control system, a step input is usually used. Hint: See example-3. 

7. Model the following control system having a plant transfer function 

(G(s))=
2
nn

2

2
n

ωsζω2s

ω


 and unity feedback transfer function (H(s)). Find the time 

response according to:  

a) ζ = 0 and ωn = 2. 

b) ζ = 0.1 and ωn = 4. 

c) ζ = 1 and ωn = 8. 



EXPERIMENT-SIX: SIMULINK  

 

 (6-20) 

8. Build the following communication system model. The model, shown in the following 

figure, contains the most basic elements of a communication system: a source for the 

signal, a channel with noise, and means of detecting errors caused by noise.  

 

Set the Error probability for the Binary Symmetric Channel Block 0.01, 0.05, 0.1 

and 1.0, and the sampling rate for Bernoulli Binary Generator Block 0.001. 

Connect the blocks and display the following information for each value of Error 

probabilities: 

 The bit error rate.  

 The number of errors.  

 The total number of bits that are transmitted. 

Hint: See example-4, page (6-16). 

 

9. Repeat problem-7 but replace the Binary Symmetric Channel Block by the AWGN 

Channel Block with signal to noise ratio (SNR) equal to 100, 1000, and 10000 dB. 

Hint: You can get the AWGN Channel Block from the Channels sublibrary in 

Communications blockset library and it looks like the figure below. For more information, 

see example-4, page (6-16).    

 




